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Legal information 
Use of application examples 

Application examples illustrate the solution of automation tasks through an interaction of several 
components in the form of text, graphics and/or software modules. The application examples are 
a free service by Siemens AG and/or a subsidiary of Siemens AG (“Siemens”). They are non-
binding and make no claim to completeness or functionality regarding configuration and 
equipment. The application examples merely offer help with typical tasks; they do not constitute 
customer-specific solutions. You yourself are responsible for the proper and safe operation of the 
products in accordance with applicable regulations and must also check the function of the 
respective application example and customize it for your system. 
Siemens grants you the non-exclusive, non-sublicensable and non-transferable right to have the 
application examples used by technically trained personnel. Any change to the application 
examples is your responsibility. Sharing the application examples with third parties or copying the 
application examples or excerpts thereof is permitted only in combination with your own products. 
The application examples are not required to undergo the customary tests and quality inspections 
of a chargeable product; they may have functional and performance defects as well as errors. It is 
your responsibility to use them in such a manner that any malfunctions that may occur do not 
result in property damage or injury to persons. 
 

Disclaimer of liability 
Siemens shall not assume any liability, for any legal reason whatsoever, including, without 
limitation, liability for the usability, availability, completeness and freedom from defects of the 
application examples as well as for related information, configuration and performance data and 
any damage caused thereby. This shall not apply in cases of mandatory liability, for example 
under the German Product Liability Act, or in cases of intent, gross negligence, or culpable loss of 
life, bodily injury or damage to health, non-compliance with a guarantee, fraudulent 
non-disclosure of a defect, or culpable breach of material contractual obligations. Claims for 
damages arising from a breach of material contractual obligations shall however be limited to the 
foreseeable damage typical of the type of agreement, unless liability arises from intent or gross 
negligence or is based on loss of life, bodily injury or damage to health. The foregoing provisions 
do not imply any change in the burden of proof to your detriment. You shall indemnify Siemens 
against existing or future claims of third parties in this connection except where Siemens is 
mandatorily liable. 
By using the application examples you acknowledge that Siemens cannot be held liable for any 
damage beyond the liability provisions described. 
 

Other information 
Siemens reserves the right to make changes to the application examples at any time without 
notice. In case of discrepancies between the suggestions in the application examples and other 
Siemens publications such as catalogs, the content of the other documentation shall have 
precedence.  
The Siemens terms of use (https://support.industry.siemens.com) shall also apply.  
 

Security information 
Siemens provides products and solutions with industrial security functions that support the secure 
operation of plants, systems, machines and networks. 
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. 
Siemens’ products and solutions constitute one element of such a concept. 
Customers are responsible for preventing unauthorized access to their plants, systems, machines 
and networks. Such systems, machines and components should only be connected to an 
enterprise network or the Internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.  
For additional information on industrial security measures that may be implemented, please visit 
https://www.siemens.com/industrialsecurity. 
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats. 
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
at: https://www.siemens.com/industrialsecurity. 

https://support.industry.siemens.com/
https://www.siemens.com/industrialsecurity
https://www.siemens.com/industrialsecurity
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1 Task 

1.1 Overview 

Introduction 

In the pharmaceutical industry, the food and beverage sector or in other industries, 
documentation of operator actions in terms of tracking and tracing is becoming 
increasingly important. 
Electronic documentation of operator actions ensures that all relevant operator 
actions during the production process are stored and, where necessary, 
acknowledged by the operator by an electronic signature and a comment.  

Another requirement is location-independent access to process data to allow 
operator control and monitoring of a running process using MS Internet Explorer or 
even Terminal Services. 

Overview of the automation task 

The figure below provides an overview of the automation task. 

Figure 1-1  

LAN

Prozessbus

Internet

 

Description of the automation task 

The task is to allow full tracking and tracing, indicating who operated what when 
where. At the same time, it must be ensured that the logged operator actions are 
tamper-proof and that they can be read at any time. 

Operator actions must be recorded irrespective of whether they are performed over 
the Internet or on site using a web client or terminal client. 
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1.2 Requirements 

• Operation of a process must fully document “who” operated “what” “when” 
“where” and, where necessary, “for what reason”. 

• After a specific time without having performed an operator action, a logged-in 
user must be automatically logged out. 

• Operation must be independent of the operating path (local/remote using 
WebNavigator or Terminal Services). 
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2 Solution 

2.1 Overview 

Schematic layout 

The figure below shows a schematic overview of the most important components of 
the solution: 

Figure 2-1 

LAN

Prozessbus

Internet

WinCC WebClient WinCC WebClient
Terminal Client

WinCC RT

WinCC WebServer

WinCC WebClient +

Terminal Server

 

 

Setup 

The configuration consists of 

• the PC with the connection to the controller, 

• one or several web clients (optional), 

• one or several terminal clients (optional). 

 

Note When using at least one terminal client, a terminal server has to be set up on 
the PC; it is then mandatory to use the Windows Server 2008 R2 or Windows 
Server 2012 R2 operating system. 

If no terminal clients are required, Windows 7 or Windows 8.1 can instead be 
used as an operating system. 
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Delimitation 

This application does not include a description of 

• operating system installation 

• SIMATIC software installation (WinCC Professional, options). 

 

Basic knowledge of these topics is assumed. 

Assumed knowledge 

Basic knowledge of the SIMATIC WinCC Professional automation software and the 
Microsoft Windows operating system is required. 

2.2 Description of the core functionality 

Using examples, this application shows the use of the SIMATIC WinCC 
WebNavigator option in conjunction with SIMATIC Logon to document process 
interventions with user-defined operator messages. 

It differentiates between the VBS and C script languages that are available in 
SIMATIC WinCC Professional.  

The application also explains the difference between logging operations on a 
standard operator station and operations that are performed using a SIMATIC 
WinCC WebNavigator Client. 

 

It shows how to 

• automatically start the WinCC WebClient when a user logs on to Windows. 

• start the WinCC WebClient with a default user if it has previously been 
terminated by automatic logout due to inactivity. 

• log on a new user during an active web session. 
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2.3 Hardware and software components 

2.3.1 Validity 

This application is valid for 

• WinCC Professional V15.1 or later 

• SIMATIC Logon V1.5 SP3 or later 

• SIMATIC WinCC/WebNavigator V15.1 or later 

 

2.3.2 Components used 

The application was created with the following components: 

Hardware components 

Table 2-1 

Component Qty Article number Note 

PC  1 E.g. SIMATIC IPCs 

http://www.siemens.com/ipc 

Web Server 

SIMATIC ITC1500 1 6AV6646-1AB22-0AX0 Terminal Client (optional) 

 

Software components 

Table 2-2 

Component Qty Article number Note 

SIMATIC WinCC Professional 
V15.1 

1 6ES7822-1..05-  

SIMATIC Logon V1.5 SP3 1 6ES7658-7..51-0Y.0  

SIMATIC WinCC/WebNavigator 1 6AV2107-0K.00-0B.0  

Windows 
Server 2008 R2 SP1 or 

Windows 
Server 2012 R2 

1  Only necessary 
when used as a 
terminal server. 

Windows 7 or Windows 8.1 1  Sufficient if no 
terminal client is 
used. 

 

Example files and projects 

The following list includes all files and projects that are used in this example. 

Table 2-3 

Component Note 

109479441_RecordOperatorActions_DOCU_v11.zip This zip file includes the 
WinCC Professional project. 

109479441_RecordOperatorActions_DOCU_v11_e.pdf This document. 

http://www.siemens.com/ipc
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3 Mode of Operation 
Generally, this application differentiates between two scenarios: 

• The WebNavigator Server is operated on a WinCC single-/multi-user system 
and the clients connect directly to the WebNavigator Server via 
WinCCViewerRT.  

• Together with a WinCC single-/multi-user system, the WebNavigator Server is 
operated on a terminal server. The clients connect to the WebNavigator Server 
within a terminal session. 

3.1 Plant configuration with the SIMATIC WinCC 
WebNavigator Client 

• The following software is installed on a workstation: 

– Microsoft Windows Server 2008 R2 or Microsoft Windows 7 

– SIMATIC WinCC Professional 

– SIMATIC WinCC WebNavigator Server 

– SIMATIC Logon 

• Using the SIMATIC WinCC WebNavigator Client, the SIMATIC WinCC 
WebNavigator Server is accessed from remote computers. 

 

Figure 3-1 

LAN

Prozessbus

- Microsoft Windows Server 2008 SR2 / Windows 7

- WinCC Professional RT

- WinCC WebNavigator Server

- Windows 7

- WinCC WebNavigator Client
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3.2 Plant configuration with a terminal server 

• The following software is installed and configured on a server: 

– Microsoft Windows Server 2008 R2 with terminal functions 

– SIMATIC WinCC Professional 

– SIMATIC WinCC WebNavigator Server 

– SIMATIC Logon 

• Using a switch, several SIMATIC Thin Clients can connect to the server. The 
SIMATIC WinCC WebNavigator Server is accessed on the local system. No 
separate SIMATIC WinCC WebNavigator Clients are required on the SIMATIC 
Thin Clients. 

 

Figure 3-2 

LAN

Prozessbus

Industrial Thin Clients

- Microsoft Windows Server 2008 SR2

- WinCC Runtime Professional

- WinCC WebNavigator
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4 Configuring the web server 
The configurations in this chapter require that the following components be 
installed: 

• SIMATIC WinCC Professional Runtime 

• SIMATIC WinCC WebNavigator 

• SIMATIC Logon 

4.1 Installing the web server 

Additional Windows components need to be installed for the operation of WinCC 
Professional via remote access. 

 

Note When installing the WebNavigator, the required settings are usually made by the 
installation routine.  

However, make sure to check all settings using the following table, especially 
when using Terminal Services. 

 

Table 4-1 

No. Action 

1.  Windows 7 

• Open the control panel via "Start > Control Panel". 

• Click on the "Programs" category or the "Programs and Features" setting. 

• Click on "Turn Windows features on or off". 

• Activate the components stated under 2. 

 

Windows Server 2008 

• In the Server Manager, Roles Summary, click on "Add roles". 

• Select the “Web server (IIS)” entry under “Server Roles”. 

• Select the components stated under 2. under "Role Services". 

2.  • Web Management Tools: 
IIS Management Service, IIS Management Console, IIS Management 
Scripts and Tools, IIS Metabase and IIS 6 configuration compatibility, 
IIS 6 WMI Compatibility 
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No. Action 

3.  • World Wide Web Services > Common HTTP Features: 
Default Document, Static Content 

 

4.  • World Wide Web Services > Application Development Features: 
ISAPI Extensions, ISAPI Filters, ASP (in this order) 

 

5.  • World Wide Web Services > Security: 
Request Filtering, Basic Authentication 
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4.2 Installing the web client 

Table 4-2 

No. Action 

1.  • Insert the data medium of your WinCC Runtime Professional application into 
the drive and select the installation routine. 

• Confirm the dialog box with “Next”. 

 

2.  • Select “Modify/Upgrade”, if WinCC Professional Runtime is already installed 
on this computer. 

• Confirm the dialog box with “Next”. 

 



4 Configuring the web server 

4.2 Installing the web client 
 

WinCC/WebNavigator - Record Operator Actions 
Entry ID: 109479441,    V1.1,    09/2019   14 
 

©
 S

ie
m

e
n
s
 A

G
 2

0
1
9
 A

ll 
ri

g
h
ts

 r
e
s
e
rv

e
d
 

No. Action 

3.  • Select the desired product languages. 

• Confirm the dialog box with “Next”. 

 

4.  • Select the options “SIMATIC WinCC WebNavigator” and “SIMATIC Logon”.  

• Confirm the dialog box with “Next”. 

 

Note 

The “SIMATIC Logon” component is required in this application for user 
administration and is not included in the WebNavigator. 
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No. Action 

5.  • Read the terms of the license agreements and the security information and 
confirm. 

• Confirm the dialog box with “Next”. 

 

6.  • Accept the security settings for this computer. 

• Confirm the dialog box with “Next”. 
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No. Action 

7.  • An overview of the components to be installed is displayed. 

• Confirm the dialog box with “Modify” when re-installing or “Install” in case of 
a first time installation. 

 

8.  The installation routine is started. 
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4.3 Configuring the web server 

To enable the IIS (Internet Information Server) to provide the images of the web 
server, the web server must be configured. 

Start the web server via “Start > Siemens Automation > Options and Tools > HMI 
Tools > WinCC WebConfigurator”. 

 

Table 4-3 

No. Action 

9.  In the WebNavigator context menu, open “WebConfigurator”. 

 

10.  Select to create a new or an additional web site. 
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No. Action 

11.  Confirm the next dialog box with “Next”. 

 

12.  As the default web page, select “WebClient.asp” and click on “Next” to confirm 
your selection. 
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No. Action 

13.  Take over the firewall settings and click on “Finish” to confirm your selection. 

 

14.  Close the following dialog box using the “OK” button and restart the computer. 
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4.4 Setting up the start parameters of the Web Viewer 

Secure access to the WebNavigator server via the “WinCCViewerRT” component 
of the WinCC Web Client requires that a parameter file be created. 

 

Note • When using the “WinCCViewerRT” Web Viewer, the settings have to be made on 
both the web server and a web client. 

• On the web server, the settings are only necessary when using Terminal Services 
(access via terminal client). 

• These settings are not required on the terminal client. 

 

NOTICE If, when accessing the WinCC Web Server, you are not using its Terminal 
Services – thus running the WinCC Web Client on a separate PC –, the 
“WinCCViewerRT” component of the WinCC Web Client must only be 
started via the logon script described in chapter 4.5. 

The start parameters explained in this chapter must then be set on the 
WinCC Web Client PC. 
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Table 4-4 

No. Action 

15.  In the start menu, select "Start > All Programs > Siemens Automation > Options 
and Tools > HMI Tools > WinCCViewerRT". 

 

Configuration on the web server: 

Start the “WinCCViewerRT.exe” component on the web server if the terminal 
server is to be used for the access. 

Configuration on the web client: 

Start the “WinCCViewerRT.exe” component on the web client if the IIS is to be 
used for the access. 

 

Notes 

• Both configuration types are independent of one another; the two access 
types can also be used simultaneously. 

• The default installation path for the Web Viewer is  
"C:\Program Files (x86)\Siemens\Automation\SCADA-RT_VXX\WinCC\ 
Webnavigator\Client\bin\...“. 

• The pages for setting up the configuration for the WinCCViewerRT are only 
offered when calling the component “WinCCViewerRT.exe” for the first time. 
If you have already made these settings and want to configure it again, you 
must delete the existing configuration file “WinCCViewerRT.xml” in 
C:\Users\<user name>\Appdata\LocalLow\Siemens\SIMATIC.WinCC\ 
WebNavigator\Client”. 
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No. Action 

16.  Configuration on the server: 

Apply the default address “http://localhost” – the WebNavigator Client will be run 
locally on the server. 

 

Configuration on the client: 

Enter the WebNavigator server address, for example “http://192.168.0.1” – the 
WebNavigator Client will not be run on the server. 

 

Note 

The “Username” and “Password” fields are not configured. When starting, users 
must individually log on to the WebNavigator Server. 
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No. Action 

17.  • Leave the dialog window for the configuration settings open and create the 
folder “C:\NetLogon” in the Windows Explorer. 

• In the properties dialog of the folder, in the “Security” tab, enable read rights 
for the user “Everyone”. 
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No. Action 

18.  As a configuration file, specify the “C:\NetLogon\” path and name the 
configuration file “NoUser.xml”. 

 

19.  In the “Parameters” tab, make the following settings: 

• Check “Disable Keys”. 

• Set the hotkeys for the property sheet to “None”. 
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No. Action 

20.  In the “Graphics Runtime” tab, make the settings as shown in the screen shot. 

 

Note 

Optionally, a start screen can be selected. Otherwise, the settings from WinCC 
User Administrator will be applied. 

 

21.  In the “Runtime” tab, make the following settings: 

• Check “Enable monitor keyboard”. 

• Set “Automatic logout” to “5” minutes. 
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No. Action 

22.  Confirm the dialog box with “OK”. 

The configuration file is saved in the “C:\NetLogon” folder and WinCCViewerRT 
is started. 

 

Note 

In the future, “WinCCViewerRT” must be started with this configuration file. 

 

 

Note For more information on the configuration of the “WinCCViewerRT” Web Viewer, 
please refer to this FAQ: 

https://support.industry.siemens.com/cs/ww/en/view/46824563 

 

  

https://support.industry.siemens.com/cs/ww/en/view/46824563
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4.5 Setting up the logon script of the Web Viewer 

Secure access to the WebNavigator Server via the “WinCCViewerRT” component 
of the WinCC Web Client requires that a logon script be created. 

 

Note • The settings have to be made on the web client only when using the 
“WinCCViewerRT” Web Viewer. 

• These settings are not required on the web server. 

• These settings are not required on the terminal client. 

 

NOTICE If, when accessing the WinCC Web Server, you are not using its Terminal 
Services – thus running the WinCC Web Client on a separate PC –, the 
“WinCCViewerRT” component of the WinCC Web Client must only be 
started via the logon script described in this chapter. 

Running the logon script requires the start parameters described in 
chapter 4.4. 

 

Table 4-5 

No. Action 

23.  Use the Explorer context menu to create a new text file in the “C:\NetLogon\” 
folder. 
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No. Action 

24.  • Rename the text file “New text file.txt“ in “NoUser.bat”. 

• Confirm the question whether you want to rename the file with “Yes”. 
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No. Action 

25.  • Select the “NoUser.bat” file and in the context menu, select the “Edit” 
command. 

• Write the following text to the batch file: 
"C:\Program Files (x86)\Siemens\Automation\SCADA-
RT_Vxx\WinCC\Webnavigator\Client\bin\WinCCViewerRT.exe" /maximized 
C:\NetLogon\NoUser.xml 

• Save the batch file. 

 

Note 

The path name may have to be adjusted to your environment. 

 

26.  Use the “File > Save” and “File > Exit” menu items to save and close the file. 
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No. Action 

27.  Both the configuration file and the just created batch file are now located in the 
“C:\NetLogon” folder. 
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4.6 Setting up a user of the Web Viewer 

Secure access to the WebNavigator Server via the “WinCCViewerRT” component 
of the WinCC Web Client requires that a user be set up. 

 

Note • On the web server, the settings are only necessary when using Terminal Services 
(access via terminal client). 

• These settings are not required on the web client. 

• These settings are not required on the terminal client. 

 

NOTICE Make sure that the “WinCCViewerRT” component of the WinCC Web Client 
is started only via the logon script described in chapter 4.5. 

Running the logon script requires the start parameters described in 
chapter 4.4. 

 

Table 4-6 

No. Action 

28.  Select <Windows> + <R> „compmgmt.msc“ to call Computer Management. 

29.  Go to “Local Users and Groups > Users”. 
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No. Action 

30.  Use the “Users” context menu to create a new user for logon to the terminal server.  

 

31.  • In both “User name” and “Full name”, enter “WebUser1”. 

• Select the “Create” button to finish and close the dialog box.  
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No. Action 

32.  Use the context menu to open the Properties dialog box of the just created user. 
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No. Action 

33.  Select the “Member Of” tab and click on the “Add…” button. 

 

34.  Click on the “Advanced…” button to expand the “Select Users” dialog box. 
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No. Action 

35.  • Click on the “Find Now” button and select the “Remote Desktop Users” item 
from the list. 

• Close the dialog box via the “OK” button. 

 

36.  • The system now enters the computer name and group name as an object 
name to be used. 

• Use the “OK” button to close this dialog box and the following one. 
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5 Configuration of the terminal server 
The installation steps described in this chapter refer exclusively to the installation of 
Terminal Services and their configuration. 

System requirements 

The following steps must already have been performed and are not discussed in 
this chapter: 

• Installation and configuration of the “Windows Server 2008” operating system. 

• Installation and configuration of SIMATIC WinCC Professional. 

• Installation and configuration of WinCC WebNavigator Server. 

 

NOTICE The “SIMATIC WinCC” and “WinCC WebNavigator Server” programs must 
not run under Terminal Services and must therefore be installed on the 
server before enabling Terminal Services. 

“WinCC WebNavigator Client” must be installed on the server using the 
“Add or Remove Programs” dialog box in the Control Panel. 

Since this dialog box uses the server’s installation mode, subsequent 
configuration of the applications is possible for all users and not just for 
the one that installed the application. 

 

Installation order 

For a successful connection of the WebNavigator Client via Terminal Services of 
the operating system, it is mandatory to follow the installation steps listed in the 
table below: 

 

Table 5-1 

Installation 
procedure 

Software to be installed 

37.  Microsoft Windows Server 2008 operating system without Terminal 
Services 

38.  Microsoft Windows Service Packs and hot fixes 

39.  SIMATIC WinCC Professional 

40.  WinCC WebNavigator server 

41.  Terminal Services for the Windows Server 2008 operating system 

42.  WinCC WebNavigator client 
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5.1 Installation of the Terminal Services 

Table 5-2 

No. Action 

43.  • In the Server Manager, Roles Summary, click on "Add roles". 

• Select the “Remote desktop services” entry under “Server Roles”. 

• Confirm the dialog box with “Next”. 

 

44.  Confirm the selection with the “Next” button. 
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No. Action 

45.  • Activate the items “Remote Desktop Session Host” and “Remote Desktop 
Licensing”. 

• Confirm the dialog box with “Next”. 

 

46.  Confirm the next dialog box with “Next”. 
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No. Action 

47.  • Under “Authentication Method”, select “Require Network Level 
Authentication". 

• Confirm the dialog box with “Next”. 

 

48.  • Select “Per User” licensing mode. 

• Confirm the dialog box with “Next”. 
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No. Action 

49.  To add groups or users, click on “Add...”. 

 

50.  To open the search dialog, click on “Advanced…”. 
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No. Action 

51.  To find users or groups, click on “Find Now”. 
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No. Action 

52.  • Under the displayed search results, either select the already existing user 
“WebUser1” (see chapter 4.6) or the group “TERMINAL SERVER USER”. 

• Confirm the selection with the “OK” button. 

 

53.  Close the dialog box with “OK”. 
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No. Action 

54.  Confirm the dialog box with “Next”. 

 

55.  Confirm the dialog box with “Next”. 
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No. Action 

56.  • Set the checkmark at “Configure a discovery scope for this license server”.  

• Select the installation location of the license data base with “Browse...”. 

• Confirm the selection with “Next”. 

 

57.  Confirm the selection with the “Install” button. 
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No. Action 

58.  The installation status gives you an overview of the progress of the installation. 

 

59.  Then click the “Close” button to close the dialog window. 
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No. Action 

60.  Select “Yes” to restart the computer. 

 

61.  After restarting the computer, close the dialog with the “Close" button. 
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5.2 Configuration of the terminal server 

Table 5-3 

No. Action 

62.  Call the Terminal Services Configuration with <Windows> + <R> “tsconfig.msc”. 

63.  Select the “RDP-Tcp” connection and use the context menu to open the 
Properties dialog box of the connection. 
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No. Action 

64.  • In the “Environment” tab, check the “Start the following program when the 
user logs on:” option. 

• In the “Program path and file name:” field, enter the following string: 
 
"C:\Program Files (x86)\Siemens\Automation\SCADA-
RT_Vxx\WinCC\Webnavigator\Client\bin\WinCCViewerRT.exe" /maximized 
C:\NetLogon\NoUser.xml 
 
Note 
Adjust the path to the respective installation directory of your operating 
system and observe the two spaces in the string. 

• Use the “OK” button to close the Properties dialog box. 

• Close the “Terminal Services Configuration” window. 
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6 Commissioning the Application 
Basic settings to start up the demo project. 

 

Table 6-1 

No. Action 

65.  The “CC_Admins”, “CC_Technic”, “DefaultGroup” and “DefaultWebUserGroup” 
groups are created in the WinCC Professional demo project. 

 

66.  • Select <Windows> + <R> „compmgmt.msc“ to call the Computer 
Management of the server. 

• Create identical groups in Windows User Management. 
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No. Action 

67.  In the relevant groups, create the users with which the WinCC project will later be 
operated (see chapter 4.6). 

 

Note 

The “SIMATIC Logon” option package is used for this application. Therefore, the 
users are not created in WinCC “User Administrator” but directly in the Windows 
operating system. 
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No. Action 

68.  Ensure that the users are a member of both the group “SIMATIC HMI” and the 
group “Remote Desktop Users”. 
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7 Operating the Application 

7.1 Overview 

The demo project consists of two different screens. One screen shows an example 
of the acquisition and display of different process value archive data. 

The second screen includes the WinCC Alarmcontrol. It provides the option to 
generate operator messages using different methods. 

Using two buttons in the top right corner, you can switch between the screens. 

The Alarm screen is described in greater detail in the following section. In this 
screen, an operator message can be generated in three different ways. These 
ways are displayed in the WinCC Alarmcontrol. The Alarmcontrol indicates origin, 
source, event, batch name and operator action. Individual adjustments can be 
made in the Alarm Logging Editor or in the Alarmcontrol settings. 
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7.2 Operator message structure 

To document operations during runtime, a user-defined operator message with 
message number 1700 was created in the WinCC Alarm Logging Editor. The 
following tables show the used user and process value blocks, including their 
contents. 

 

Note The following FAQ shows an example of the generation of user-defined operator 
messages in WinCC: 

https://support.industry.siemens.com/cs/ww/en/view/24325381 

 

User text blocks 

Table 7-1 

User 

text block 

Name Structure 

Text_Block1 Source @2%s@\@10%s@ 

Text_Block2 Area @9%s@ 

Text_Block3 Event @7%s@ @6%s@ new = @5%s@ @8%s@ old = @4%s@ @8%s@ 

Text_Block4 Batch 
name 

@1%s@ 

Text_Block5 Operation @7%s@ @6%s@ new = @5%s@ @8%s@ old = @4%s@ @8%s@ 

 

Note The user text blocks can be designed as desired. 

 

Process value blocks 

Table 7-2 

Process value block Name Content 

Processvalue_Block1 Process value:  1 Batch name 

Processvalue_Block2 Process value:  2 Computer Name 

Processvalue_Block3 Process value:  3  

Processvalue_Block4 Process value:  4 Old value 

Processvalue_Block5 Process value:  5 New value  

Processvalue_Block6 Process value:  6 Operator control text 

Processvalue_Block7 Process value:  7 users 

Processvalue_Block8 Process value:  8 Unit 

Processvalue_Block9 Process value:  9 Area 

Processvalue_Block10 Process value:  10 Source 

 

NOTICE If you are using a process value block allocation that differs from the one 
shown in the table, the “ISALG_OperationLogForWeb” (C Script) or 
“CreateOperatorInputMessage” (VB Script) scripts must be adapted 
accordingly. 

 

https://support.industry.siemens.com/cs/ww/en/view/24325381
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7.3 Description of the buttons 

Table 7-3 

No. Button Explanation 

1 

 

Visible only on the standard client. 
Calls the dialog box for login via SIMATIC Logon. 

2 

 

Visible only on the WebNavigator Client. 
Closes the current WinCCViewerRT component and starts it with a 
“NoUser” configuration. 
A Login dialog box is displayed, where you can log in individually. 

3 

 

An operator message is created using VB Script. The “TagForAudit” 
WinCC tag is incremented by one to simulate different contents in 
the operator messages. 

4 

 

An operator message is created using VB Script. The user is 
prompted to enter a new value for the “TagForAudit” WinCC tag. 

5 

 

Creates an operator message using C-Script. During this process, 
an internal C tag is incremented by 0.1. 

6 

 

Opens a picture window where you can configure the operator 
message data (area, source, etc.). 

7 
 

Operator-controllable only on the standard client. 
Exits Runtime. 

8 
 

Change between German and English 
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7.4 Description of the scripts 

Table 7-4 

No. Action Remarks 

1 WebNavigator.pdl / OpenPicture C-Script that sets the “Visible” property for the “Login”, 
“Logout and show login dialog” and “Deactivate” buttons. 

2 Start.pdl / object „ScriptField“ / 
background color 

C-Script that detects automatic logout of a user and 

subsequently terminates WinCCViewerRT. WinCCViewerRT 
is then automatically started with a DefaultUser. 

In this script, it may be necessary to adjust the path to the 
WinCCViewerRT.exe and DefaultUser.xml files, depending 
on where the files are located. 

3 WebNavigator.pdl / object 
„Logout_and_show_logindialog“ / 
Press Left 

C-Script that terminates the current WinCCViewerRT 
component and restarts it with a “NoUser” configuration.  

In this script, it may be necessary to adjust the path to the 
WinCCViewerRT.exe and NoUser.xml files, depending on 
where the files are located. 

4 Creating an alarm using VB script 

WebNavigator.pdl / object 
„Button2“ and „Button3“ / mouse 
click 

A detailed description is stored in the respective script. 

5 Creating an alarm using C-Script 

WebNavigator.pdl / object 
„Button1“ / mouse click 

A detailed description is stored in the respective script. 
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7.5 Direct remote access without Terminal Services 

This plant configuration does not include a terminal server. Each client that 
accesses the WebNavigator Server requires a separate installation of the 
WebNavigator Client. 

 

Table 7-5 

No. Action 

69.  Start the “WinCCViewerRT” component of the WinCC Web Client using the logon 
script and the respective start parameters of the configuration file. 

 

Note: 

For the relevant preparations, please refer to chapter 4.4 and chapter 4.5. 

 

70.  WinCCViewerRT starts according to the configuration file. 
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No. Action 

71.  After the configured logout time, the user is automatically logged out. 

 

Note 

This dialog box is not visible or visible only for a short time since a WinCC script 
queries this dialog box and closes it once it appears. 

 

72.  The currently open WinCCViewerRT component is automatically closed and a 
new instance is started with the “DefaultUser” user. 

 

73.  Use the “Logout and show login dialog” button to close the currently open 

WinCCViewerRT component and open a new instance with a configuration file 
without login information. 

 

Note 

Since no login information is stored, a login dialog box opens, where you can log 
in individually. 

 

 

Note When clicking on Cancel in the login dialog box, an info picture will be displayed. 
Press the F5 key to reopen the login dialog box. 
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7.6 Indirect remote access via Terminal Services 

In this plant configuration, any client (e.g., thin client) logs on via the terminal 
server. An automatic logon script is then started, which opens the WebNavigator 
Client to access the WebNavigator Server. 

 

Table 7-6 

No. Action 

74.  On the web client, select <Windows> + <R> “mstsc” to call the Remote Desktop 
connection. 

 

75.  • In the “Computer” field, enter the IP address of the web server.  

• Select the “Connect” button to establish the connection. 

• Log on with user “WebUser1”. 

 

Note 

For the relevant preparations, please refer to chapter 4.6. 
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No. Action 

76.  Log on with user “WebUser1”. 

 

Note 

For the relevant preparations, please refer to chapter 4.5. 

 

77.  Once a user has successfully logged on, the stored script starts WinCCViewerRT. 
The user is prompted to enter his/her logon data. 

 

Note 

“Welcome to localhost” is always displayed since, due to logon to the terminal 
server, the web server operates on the local system. 
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No. Action 

78.  After successful logon, the project is loaded. 

 

79.  After the configured time, the user is automatically logged out. 

 

Note 

This dialog box is not visible or visible only for a short time since a WinCC script 
queries this dialog box and closes it once it appears. 

 

80.  The currently open WinCCViewerRT component is automatically closed and a 
new instance is started with the “DefaultWebUser” user. 
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No. Action 

81.  Use the “Logout and show login dialog” button to close the currently open 
WinCCViewerRT component and open a new instance with a configuration file 
without login information. 

 

Note 

Since no login information is stored, a login dialog box opens, where you can log 
in individually. 

 

 

Note When clicking on Cancel in the login dialog box, an info picture will be displayed. 
Press the F5 key to reopen the login dialog box. 

 

 

NOTICE If you prefer to use Terminal Services also for service purposes, always 
use “Logout” to log out of the server operating system. 
Otherwise, re-logon is not possible if the respective user is not 
automatically logged out after a preconfigured time. 

Direct access to WinCC via the Terminal Services (without web or terminal 
client) is not released and is your responsibility. 

 



8 Further Notes 
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8 Further Notes 

8.1 Completing access protection 

For system-related reasons, brief access to operating system level may be 
possible during the automatic restart of the WinCC Web Client. 

To allow as few access points as possible, it is recommended that the security 
policies in Windows be very restrictive. 

8.2 Changing passwords 

Windows passwords can only be changed from the SIMATIC WebNavigator 
Server. This is not possible from the WebNavigator Client. For more information, 
please refer to the SIMATIC WebNavigator documentation. 

8.3 Differences when generating operator messages 

VB script 

In VBS, the HMIRuntime object for alarms supports only read access to the 
“Computername” property. As a result, when a connection has been established 
via a terminal server, the message displays the computer name of the terminal 
server and not the one of the connected remote client. 

The name of the connected client is also read out and written to process value 
block 2 and user text block 1 – however, the “Computername” column of the server 
displays the name of the terminal server. 

C-Script 

C-Script enables you to transfer also the computer name to the alarm object. Here, 
too, the client name is read out on the terminal server and written to the 
“Computername” column – this is displayed accordingly in the Alarmcontrol. 

In addition, the computer name is also written to process value block 2 and user 
text block 1. 



9 Links & Literature 
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9 Links & Literature 
Table 9-1 

 Topic 

\1\ Siemens Industry Online Support 

https://support.industry.siemens.com 

\2\ Download page of the entry 
https://support.industry.siemens.com/cs/ww/en/view/109479441 

\3\ Starting Web Viewer 

https://support.industry.siemens.com/cs/ww/en/view/46824563 

\4\ WebNavigator – Record Operator Actions for WinCC V7 

https://support.industry.siemens.com/cs/ww/en/view/49516052 

\5\ SIMATIC STEP 7 Basic/Professional V15.1 and SIMATIC WinCC V15.1 
https://support.industry.siemens.com/cs/ww/en/view/109755202 

\6\ Thin Client manual 
https://support.industry.siemens.com/cs/ww/en/view/61187980 

\7\ Thin Client Remote Configuration Center 
https://support.industry.siemens.com/cs/ww/en/view/42793847 

\8\ Thin Client configuration file 
https://support.industry.siemens.com/cs/ww/en/view/35105485 

 

 

10 History 
 

Table 10-1 

Version Date Modifications  

V1.0 02/2016 First version 

V1.1 09/2019 Update TIA Portal V15.1 

 

https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/en/view/109479441
https://support.industry.siemens.com/cs/ww/en/view/46824563
https://support.industry.siemens.com/cs/ww/en/view/49516052
https://support.industry.siemens.com/cs/ww/en/view/109755202
https://support.industry.siemens.com/cs/ww/en/view/61187980
https://support.industry.siemens.com/cs/ww/en/view/42793847
https://support.industry.siemens.com/cs/ww/en/view/35105485
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